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D O V I C O  P R O D U C T S  

 
In today’s highly competitive marketplace, you need every advantage to manage 
professional time. Track-IT Suite eliminates the time wasted, and inaccuracies of, 
manually recording data, allows you to keep track of all work-related or billable time 
and makes it easy to prepare estimates on similar past projects. 
 
This valuable asset to on-the-job productivity is also easy to use. With the click of a 
mouse, this innovative product eliminates the labor and takes the guesswork out of 
time keeping. 
 

Products included in DOVICO Track-IT® Suite 
Track-IT pro is the back-end software used for team and individual time and cost 
reporting. Basic information (clients, projects, tasks, employees, etc.) is entered into 
Track-IT pro then transmitted to Track-IT timesheet entry software (Track-IT light, 
Track-IT web edition and/or Track-IT punchclock) for time recording. Once time is 
recorded, simply approve the timesheets and use Track-IT pro to create multiple team 
and individual time and cost reports. In a typical multi-user installation for example, 
everyone uses one or more timesheet entry tools (Track-IT light, Track-IT PDA, Track-
IT web edition and/or Track-IT punchclock) on a daily basis for time entry and to view 
his or her timesheet and productivity reports. Managers use Track-IT pro weekly or 
monthly for project monitoring and reporting (by employee, team, client, project, task, 
etc.). 
 
Track-IT pro can also synchronize with Microsoft Project® and Microsoft Project 
Server® to transmit time entries to Microsoft Project in addition to Track-IT pro. 
Microsoft Project is used to create project plans and tasks assigned to each employee 
are sent to Track-IT pro. Employees use Track-IT light or Track-IT web edition to 
record their time and the time information is updated in Track-IT pro as well as in 
each project file. 
 
Track-IT pro can also connect to QuickBooks® using Track-IT Link. Track-IT Link 
permits the user to easily and quickly send billing and employee timesheet information 
to QuickBooks® for accurate payroll and/or billing purposes.   
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Track-IT pro web is the latest addition to Track-IT Suite. Track-IT pro web is a 
100% web-based version of Track-IT pro. Using Track-IT pro web, a project manager 
or administrator can accomplish their usual day-to-day Track-IT activities (approve 
timesheets, produce reports, etc) from any location and on any computer. All that’s 
required is a computer with a web browser and access to the Internet. NO CLIENT 
INSTALLATION REQUIRED. 
 

In addition to Track-IT pro and Track-IT pro web, our Track-IT Suite includes several 
state-of-the-art timesheet entry software, which suit the needs of employees in your 
business no matter what type of work they do. Employees can select from one or more 
of the following Track-IT timesheet entry tools™ for individual time/project tracking 
and reporting: 
 

 Track-IT light is a Windows-based software used by employees. Employees 
simply select the project and task they want to monitor and Track-IT tracks their 
time, provides performance information (in graphic or report format) and compares 
it to their goals. It offers users instant feedback (pie/bar charts) to help increase 
their productivity and improve their performance. Employees can track time as they 
work using a timer or enter bulk time at the end of the day, week, month, etc. 
Timesheet information can be sent to Track-IT pro and Microsoft Project (or 
Microsoft Project Server) via a network connection or over the Internet. 

 Track-IT web edition  is a web based application used by off-site and office 
based workers over the Internet or an Intranet. As with Track-IT light, simply select 
the project and task and enter the total time worked. Track-IT web edition provides 
performance information (in report format) and compares it to your goals. It uses a 
Microsoft n-tiered architecture for high performance and great scalability. 
Application processing, business processing, and database processing can be 
separated/combined, as needed depending upon your company’s needs. 

 Track-IT wireless is an award winning time entry tool enabling employees to 
enter time and expenses through all wireless Internet devices (ex. Web enabled cell 
phones, PDA’s, Blackberry’s etc.). Employees simply go to a single URL, and the 
Track-IT server will configure for their display and data entry type. Track-IT 
wireless is automatically installed with Track-IT web edition. 

 Track-IT PDA is a PDA-based software used by employees to enter time and 
expenses through their Personal Digital Assistants. Palm synchronization is 
supported. (Not included in Demo Software) 
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 Track-IT punchclock is a Windows-based software used by production line 
workers. Traditional punch clocks usually require complicated setup, installation and 
servicing which can in turn be expensive. With very little setup, Track-IT 
punchclock will work on multiple computers throughout your business and allow for 
multiple user access. Each employee can track time under a different project and 
task. 

Track-IT Suite has won many awards including five out of five stars by Zdnet “Best 
Business Software, Editors Choice. 
 

Highlights 
 

Track-IT pro reporting 

 View, graph and report ANY period of your choice 

 Create custom reports 

 Filter sorts for enhanced reporting 

 Report on project estimates or budgets 

 Export reports in as many as 70 formats including PDF, Excel, Word, 
OBDC, HTML, XML and many more 

 
 

Track-IT pro data entry 

 Enter multiple rates for overtime, regular, etc. 

 Unlimited client addresses, notes and telephone numbers 

 Use as many levels as necessary > 1,000,000 

 Unlimited user defined custom fields 

 Microsoft Project and Project Server two way compatibility 

 Customizable security level access 
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 Configurable date & currency formats 

 Customizable terminology  

 Ability to capture company specific information through use of client 
definable fields 

 
 

Track-IT pro web data entry 

 100 % web based 

 Enter multiple rates for overtime, regular hours, etc. 

 Unlimited client addresses, notes and telephone numbers 

 Use as many levels as necessary (> 1,000,000) 

 Customizable security level access 

 Ability to capture company specific information through use of client 
definable fields 

 
 

Track-IT pro web reporting 

 View or print graphs and reports for ANY period of your choice 

 Report on project estimates or budgets  

 Filter sorts for enhanced reporting 
 
 

General 

 Advanced easy to use interfaces (GUI) 

 Multi-user client-server technology and 100% web based 

 Robust & secure solution with Audit trail 

 Fast & easy seamless future upgrades  
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Employee timesheet entry  

 Remote employee timesheet entry (Web, Internet, Intranet, WAN, 
VPN) 

 Employees can set their own specific targets and goals 

 Enter time without spending valuable system resources or interrupting 
other applications 

 Employees can use any timesheet entry tools (Track-IT web edition, 
Track-IT PDA, Track-IT light, Track-IT punchclock) for easy timesheet 
entry 

 Track-IT light, Track-IT web edition and Track-IT punchclock are 
stand-alone products that are linked by the data that they 
communicate. Some benefits arise from having the software stand-
alone: 

 
 Reduced Training Time: Because the majority of employees will be entering their 

time using one of the Track-IT time tracking tools. Employees do not need to 
know how to use management tool and therefore reduces training time. These 
time entry tools can be learned in 15 minutes or less. 

 Efficient Resource Use: Because Track-IT light is used on a daily basis and with 
any other open application, resource use is especially important to ensure that 
the computer is not slowed down. Track-IT light uses very little computer 
resources so that it does not slow down the computer, or interfere with other 
running applications. 

 Portability: Some employees who need to use portable computers will need to 
run Track-IT light on their local disk drive to enter time. The software is easy to 
install and needs minimum system requirements. 

 Easy Deployment: As new changes (upgrades) to the software become available, 
deployment needs to be fast and easy. Thanks to Smart Upgrade Technology. It 
is a simple matter of changing the host (server) software. 
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Main features 

 Prepares cost estimates by client, project, task, team, employee, and more. 

 Keeps track of time and costs as work is being done. 

 Enables employees to record and monitor their own time and costs relating to their 
assigned projects and related tasks. 

 Provides access to a variety of reports and graphs for any selected period: 
Timesheet information, billable and non-billable information, client, project and 
task costs compared with estimated costs, etc. 

 Security can be assigned to Track-IT pro and Track-IT pro web: an employee may 
be allowed to access all information, another may have a more restricted access. 

 Security can be assigned to Track-IT timesheet entry tools: an employee using 
Track-IT timesheet entry tools can have features either removed or restricted. 

 Enables individual employees to keep track of their time in a variety of ways (while 
work is being done, at the end of the day, week, month, etc. using start and end 
times or bulk time). 

 Time entry is done with Track-IT light and/or Track-IT web edition and/or Track-IT 
punchclock. Track-IT light, Track-IT web edition and Track-IT punchclock use a 
live database connection to Track-IT, which enables the data to be transmitted in 
real time. 

 With Track-IT’s custom terminology, the applications within the Suite can be 
customized to conform to organizations existing terminology. Company definable 
custom fields, implemented throughout the Suite, provide the unique ability for 
organizations to record additional information specific to their organization. In the 
case of Track-IT timesheet entry tools, this feature provides “capture at the 
source” capability – the secret to accurate information retrieval. 
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P A R T  1  –  T R A C K - I T  L I G H T  

Introduction to Track-IT light 
On the road to better time and expense management. 

elcome to Track-IT® light, the Industry Standard in time tracking and 
productivity software from DOVICO Software. This power-packed version of 
Track-IT light combines exciting new features with the established 
functionality professionals have come to rely on. 

Track-IT light is a full-featured time tracking package designed specifically for time and 
expense tracking and reporting. It is ideally suited for professionals and companies who 
need to track time to improve personal productivity and/or to monitor projects as work is 
being done.  

Track-IT light is an efficient time tracking and 
productivity tool. Use it to monitor your tasks as you 
perform your work or enter time information after the fact at 
the end of the day, week, month, etc. Use Track-IT light 
corporate wide with Track-IT pro (or Track-IT pro web) for 
enhanced team and cost reporting. No matter what field you 
work in, Track-IT light can help you achieve optimum 
productivity. 

 

Chapter 

1 

W

I C O N  K E Y  

 Valuable information 

 Keyboard exercise 

 Workbook exercise 

 Workbook review 
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On the road to better time management 
 

 First, find out how much time you spend on your daily tasks 
 

 Set targets for each project 

 Enter your target information into the software 

 Use Track-IT light to track the hours spent on each task 

 Print the graphs and reports showing the results compared to the targets 

 
 

 Then ask yourself a few important questions 
 

 Did you achieve your targets? 

 Do you spend too much time on certain tasks? 

 Is your time spent on the best priorities? 

 What work habits do you need to change? 

 What are your new targets? 

 
For best results, use Track-IT light on a continuous basis. 
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Key features  
These are just a few of the features that are included with Track-IT light. 

 Automatically starts when employees computer is turned on or employee logs in 

 Network ready for multiple users.  

 Set performance targets & compare results 

 Tree view selection windows for fast time entry  

 Track and categorize your daily tasks 

 Automatically calculate time and expense information 

 Enter time information in a ‘stopwatch’ or in a timesheet view 

 Simple user interface for ease of use, minimum employee training time 

 Help files, tip of the day, step-by-step tutorial included for learning quickly 

 Designed for speed, and small computer resource usage 

 Notes available for each time entry created 

 Access information by dates of your choice 

 Full integration with Track-IT Suite 

 Unlimited number of projects 

 Unlimited number of tasks 

 Automatic Stop/Start when switching tasks for fast time entry (optional 
preference) 

 Optional small window stays on top of other running applications when tracking 
time or can be minimized to the windows system tray 

 Notification of overlapping times 
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 Automatic notification of too many hours worked or not enough hours worked.  

 Will not allow duplicate timesheets sent 

 View or print graphs and reports 

 Expense tracking & reporting 

 Use Track-IT light without interrupting other running software 
 
And many more… 
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System requirements 
To run Track-IT light, you need: 

 Microsoft Windows operating system version Windows 98 (or later version), or 
Windows NT 

 Personal computer using Pentium 100 MHz processor 

 Minimum 16 MB of memory (RAM) 

 2 MB Hard disk space to store offline files 

 CD-ROM drive 

 
To print, select from any printer supported by Microsoft. 

What you need to know 
Projects and Tasks are used to identify what you are tracking.   

Projects: A project or process, the subject of a task (administration, production, 
sales, etc.).   

Tasks: A task or activity (telephone, meeting, travel, etc.). Tasks are actions to 
be performed for each project. Multiple tasks are assigned to each 
project for time tracking purposes. You can create as many sub-tasks as 
necessary. 

 

In addition to keyboard shortcuts for menu actions, Track-IT light offers one-step access to 
commonly-used views through buttons on the side shortcut bar. Frequently used views are 
right at hand when you need them. The shortcut bar appears on the side of each view. 
Click the button once to go to that view. 
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 Timer view – With the click of a mouse, this innovative tool eliminates the labor 
and takes the guesswork out of time keeping. Use the Timer view to track time as 
you work. (like a stopwatch) (Menu command: View, Timer) (go to page 39) 

 Timesheet view – All time entered is saved in this Timesheet view. From this 
view, you can add, edit and delete timesheet information. It shows detailed time 
entries for any date range. (Menu command: View, Timesheet) (go to page 53) 

 Bulk Time view – Enter your total hours worked for the day or week in the Bulk 
Time view. This weekly grid lets you quickly distribute hours worked across one or 
more days or projects. Use it to copy and paste work from previous weeks or to 
edit timesheet information. This view shows rolled up time entries per project and 
task for each day of the week. (Menu command: View, Bulk Time) (go to page 45). 

 Calendar view – To view timesheet entries for a specific month. Click any day of 
the month to edit information (Menu command: View, Calendar) (go to page 59). 

 Expenses view – All expenses entered are saved in this Expense view. From this 
view, you can add, edit and delete expense information. It shows detailed expense 
entries for any date range. (Menu command: View, Expenses) (go to page 61) 

 Estimates view – To view or edit the percent completed for any currently assigned 
project (Menu command: View, Estimates) (go to page 65). 

Starting Track-IT light the first time 
When you start Track-IT light the first time, the Setup wizard will be displayed. It will 
display two screens that you can use to quickly set up Track-IT light according to your own 
preferences. You can change these and options anytime by selecting Tools, Option from 
the menu. 
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Setup screen 1 
The first setup screen is used to select the startup screen for Track-IT light. Select the one 
you will most often use (Timer view, Bulk Time view or Timesheet view) and click Next. 
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Setup screen 2 
This screen is used to select your preferred options. Select your preferences and click 
Finish. 
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Open Track-IT light 
Track-IT light requires a User ID and Password to logon. You will need to obtain these from 
the Track-IT pro administrator. This User ID and Password will be required every time you 
open Track-IT light. 

Track-IT light is able to connect to the local network or via an Internet connection 
when working off-site. 
 
For users familiar with the logon steps used in previous versions of Track-IT light, 
follow the network connection instructions. 
 

 
1. Select Start, Programs, Track-IT Suite, Track-IT light. 

 

 
 

2. Select the Network tab. 

3. If your company uses more than one database, please select the appropriate 
database from the list. 

 To open Track-IT light using a network connection: 
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 If required, click the Browse button to navigate to the wcshost.ini file and click 
Open. By default this file is located in the Track-IT installation directory. 

4. Enter your User ID. (demo database access = “RB”) 

5. Enter your Password. (demo database access = “RB”) 

6. Select the OK button to logon. 

 

 
Prerequisite: A Web Access configuration URL is required to access Track-IT light 
over the Internet. Contact your system administrator for more details. 
 

1. Select Start, Programs, Track-IT Suite, Track-IT light. 

 
 
 

2. Select the Web Access tab. 

3. Confirm or enter the Web Access configuration URL. 

 Press the Update button whenever the configuration URL is changed. 

4. If your company uses more than one database, please select the appropriate 
database from the list. 

 To open Track-IT light using an Internet connection: 
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5. Enter your User ID. (demo database access = “RB”) 

6. Enter your Password. (demo database access = “RB”) 

7. Select the OK button to logon. 

 
 
You are now ready to start tracking time.   

 Timesheet & Bulk time entry, (see pages 53 and 45) 

 Using the Timer, (see page 39) 

Track-IT light Security 
Security can be applied to Track-IT light by granting and restricting access to menu items, 
views, and time tracking operations. Security can be applied to specific employees or 
groups of employees by the manager using Track-IT pro or Track-IT pro web. 

Any menu item that has been restricted from use will be unavailable and will appear with 
an (X) character to the left of the option. For example if security restricted access to the 
bulk time view then the view menu would appear as shown below. 
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If access to the Bulk Time view has been restricted and you attempt to access the Bulk 
Time View using the side shortcut bar the following message will be displayed. 

 

Security and Permissions for Track-IT light can only be edited or modified by Managers 
or Administrators using Track-IT pro or Track-IT pro web. If you require access to 
specific menu items, views or time tracking operations that have been restricted, 
please contact your Track-IT Manager or Administrator to modify your permissions. 
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Custom Fields 
Custom fields can be implemented by your Track-IT manager to accommodate additional 
information that must be tracked when entering time and expenses. 

To determine if custom fields are required and have been implemented by your manager, 
simply select the Custom Fields tab while tracking time and expenses in the Timer, 
Timesheet, Expense and Bulk Time views. Any custom fields that have been implemented 
will be displayed on the Custom Field Tab. If the custom field tab does not contain any 
fields, then custom fields have not been implemented. The image below displays a few 
examples of how custom fields are displayed. 

 

Change Password 
The Change Password function permits the user to change their password for all 
Track-IT Suite components: Track-IT pro, Track-IT pro web, Track-IT light, Track-IT 
web edition, Punch Clock, PDA and Wireless. 
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1. Select Change Password from the Tools menu. 

2. Enter your Current password. 

3. Enter your New password. 

4. Confirm your new password. 

5. Press OK. 

 

Show Only Current Assignments 
 
The Show Only Current Assignments function will hide tasks when the date is 
outside the task’s scheduled start and end dates. When properly configured by the 
project manager using Track-IT pro or Track-IT pro web, this function hides, from the 
Track-IT light user’s views, all those tasks that are not scheduled to be worked on. 
 

 In the Timer view: Only tasks that are scheduled to be worked on, within the 
current day, are displayed.  

 In the Timesheet view: Only tasks that are scheduled to be worked on, within the 
Timesheet view’s date range, are displayed.  

Important Information 
Note that the date chosen in the Timesheet view’s Add Time entry window has 
no effect on the list of tasks displayed. Pressing the Display All button will display 
any hidden tasks. 

 
 In the Bulk Time view: Only tasks that are scheduled to be worked on within the 

Bulk Time view’s date range are displayed. 

 
 
 

 To change your password: 
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Preferences / Options  
Options in the Tools menu are used to view information, to enter your preferences and to 
set automatic options. 

Titles & Work Habits tab 
Use this tab to view default title names for project, task and value added taxes that have 
been setup in Track-IT pro. 

Titles 
This displays the default current terminology that has been set in Track-IT pro. These title 
names are displayed in column and report headings. 

 

Projects: Project or process, the subject of a task (administration, production, 
sales, etc.). 

  

 

Tasks: A task or an activity (telephone, meeting, travel, etc.). Task names are 
actions to be performed for each Project. Multiple tasks can be assigned 
to each Project for time tracking purposes. 

 

 

Value Added Tax: A fee or due imposed on the members of an organization to 
meet its expenses. There are two fields available to enter Value 
added taxes in the Expenses view. These fields are titled Value 
Added Tax 1 and Value Added Tax 2. 

Chapter 

2 



P A R T  I  –  T R A C K - I T  L I G H T  
 
 

22 

Work habits 
 
My day starts at 
This  option is used in the Timer view. Set this option to the time you normally start 

working. It is used to set a default value for the Start from last button  at the 
beginning of each day. 

 

 

1. Select Tools, Options from the menu. 

2. Select the Titles & Work Habits tab. 

3. Enter the time you usually start working in the My day starts at box. 

4. Click OK to apply your change and return to the Timer view. 

 
Auto-advise 
This option applies to the Submit option . Set this option to the minimum and 
maximum number of working hours per day. The software will advise you before sending 
your timesheet whenever a day goes beyond the set boundaries. 

 

1. Select Tools, Options from the menu. 

2. Select the Titles & Work Habits tab. 

3. Enter the least amount of hours you want to work each day before you are 
advised in the Auto-advise when sending timesheets for days that have 
less than box. 

4. Enter the most amounts of hours you want to work each day before you are 
advised in the more than box. 

5. Click OK when done. 

 
To disable Auto-advise, enter 0 in both boxes. 
 
 

 To enable my day starts at: 

 To enable Auto-advise: 
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Automatic options tab 
 
Auto-shrink 
This option is used in the Timer view. When Auto-shrink is ON, the view will be reduced (or 

shrunken) when the Start  or Start from Last  buttons are used (see below). This 
small window will stay on top of any open application.  

 

You can also manually shrink/detail the view by clicking  when tracking is ON. 

 

 
1. Select Tools, Options from the menu. 

2. Select the Automatic Options tab. 

3. Check the Auto-shrink box. 

4. Click OK when done. 

 
Auto stop/start 
This option is used in the Timer view. When this option is ON, you do not need to click 

Stop  when using the timer, while tracking time, simply select another task. The 
software will stop tracking, store the recorded timesheet entry and start tracking for the 
new selected task. 

 If Auto stop/start is ON and you want to allocate the current time worked to a 
different item, press the shift key while making your selection. 

 

 To turn Auto-shrink ON: 
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 If Auto stop/start is OFF, press the shift key while making your selection when 
you’re tracking time and it will automatically start tracking for the new 
selection. 

 
 When Auto stop/start is OFF, click items in the main list while tracking time 
and the software will continue to track time on the initial category until you 

click Stop  and re-start the timer for another task. 
 

 

 

1. Select Tools, Options from the menu. 

2. Select the Automatic Options tab. 

3. Check the Auto stop/start box. 

4. Click OK when done. 

 
 
Auto-save  
This option is used in the Timesheet view. When ON, Auto-save will automatically save 
your timesheet entries when you close the view. When Auto-save is OFF, the software will 
prompt you to save changes made when you exit Track-IT light or go to another view. If 
you answer no, you will lose any unsaved information. 

 

 

1. Select Tools, Options from the menu. 

2. Select the Automatic Options tab. 

3. Check the Auto-save box. 

4. Click OK when done. 

 
Auto-display  
This option is used in the Bulk Time view. When ON, Auto-display will automatically 
display the Project and Task for any previously entered Bulk Time. When Auto-display is 

 To turn Auto stop/start ON: 

 To turn Auto-save ON: 
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OFF, only Projects and Tasks with Bulk Time entered for that specific week will be 
displayed. 

IMPORTANT INFORMATION: 
When checked, the Bulk Time view will not display previously used projects and tasks 
when a Row Filter is in use.  
 

 

1. Select Tools, Options from the menu. 

2. Select the Automatic Options tab. 

3. Check the Auto-Display Projects and Tasks for previously entered Bulk 
Time box. 

4. Click OK when done. 

 
 
When minimizing, move to system tray 
 
Use this option as follows: 

 When checked: Track-IT light will be available from the system tray when 
minimized. 

 

 When unchecked: Track-IT light will be available from the taskbar when 
minimized. 

 

 

 To turn Auto-display ON: 
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1. Select Tools, Options from the menu. 

2. Select the Automatic Options tab. 

3. Check or uncheck the When minimizing, move to system tray box. 

4. Click OK when done. 

 
 

Startup view 
Use this tab to select which time entry screen to load when Track-IT light starts. 
 

 Timer view to enter time as you go. 

 Timesheet view to enter time on a daily basis. 

 Bulk Timesheet view to enter time on a weekly basis. 

 Expenses view to enter expenses on a daily basis. 

 Estimates view to enter estimates on a daily basis. 

 

 

1. Select Tools, Options from the menu. 

2. Select the Startup view tab. 

3. Check which time entry screen you prefer using and Track-IT light will load 
that view when it starts. 

4. Click OK when done. 

 

 To check/uncheck this option: 

 To select your preference 
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Remote Synchronization 
Track-IT light is capable of connecting to the Track-IT database either via a local area 
connection or via the Internet. 

The Remote Synchronization tab in the Options menu enables the user to modify the 
web access URL or to change the type of connection currently being used. 

 
1. Select Tools, Options from the menu bar. 

2. Select the Remote Synchronization tab. 

3. Enter or modify the Configuration URL. 

4. Press the Test Connection button to verify the URL. 

5. Click Apply then OK. 

 

 
The current connection is the one selected (Web Access or Network) 

1. Select the opposite type of connection. 

2. Click Apply then OK. 

 To add or modify the Web Access URL: 

 To change the current connection: 
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Step-by-step 
Learn to use Track-IT light in 3 easy steps 

Step 1.1 - Starting Track-IT light 
When you start Track-IT light the first time, the Setup wizard will be displayed. It will 
display two screens that you can use to quickly set up Track-IT light according to your own 
preferences. You can change these and options anytime by selecting Tools, Options from 
the menu. 

Chapter 
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The first setup screen is used to select the startup screen for Track-IT light. Select the one 
you will most often use (Timer view, Bulk Time view or Timesheet view) and click Next. 
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The second screen is used to select your preferred options. Select your preferences and 
click Finish. 

 

Step 1.2 – Basic information 
Track-IT light has two basic levels of information; Projects and Tasks: 

Projects: Project or process, the subject of a task (administration, production, 
sales, etc.). 

 
 

Tasks: A task or an activity (telephone, meeting, travel, etc.). Task names are 
actions to be performed for each Project. Multiple tasks can be assigned 
to each Project for time tracking purposes. 
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Step 1.3 - Ways to enter time 
Track-IT light offers three easy ways to enter time (1) Timer (2) Bulk Time and (3) 
Timesheet. Use the Startup view tab in Tools, Options, to select one view and Track-IT 
light will automatically go to your preferred view when it starts. 
 

 Timer view 
 
With the click of a mouse, this innovative tool eliminates the labor and takes the 
guesswork out of time keeping. Use the Timer view to track time as you work (like a 
stopwatch). 
 

Bulk Time view (Weekly time) 
 
Enter your total hours worked for the day or week in the Bulk Time view. This weekly 
grid lets you quickly distribute hours worked across one or more days or projects. Use 
it to copy and paste work from previous weeks or to edit timesheet information. This 
view shows rolled up time entries per project and task for each day of the week. 
 

 Timesheet view 
 
All time entered is saved in this Timesheet view. From this view, you can add, edit and 
delete timesheet information. It shows detailed time entries for any date range. 
 
Use a combination of 1, 2 and 3. Studies have shown that this is the most effective 
and productive way of timesheet entry. So let’s start by learning how to use the 
Timer… 
  
 
Step 1.4 - Using the Timer 
The timer (stopwatch) is extremely easy to use. You can track time in three mouse clicks 
(or in two mouse clicks if you use Auto Stop/Start). Go to the Timer view (click the 

Timer button  on the side shortcut bar). 
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1. Select the task name from the list and enter a Description (optional). 

2. Click the Start  or Start from Last  buttons. 

 

 

1. Click the Stop button . When you click this button, your time entry will be 
stored in the Timesheet view and you can edit it there if necessary. 

 
That’s it! Do this while you work and you won’t have the headache of manually 
entering your time. Plus, you don’t have to waste productive time filling out your 
timesheet at the end of the week because the task is already done. 
 

Still not convinced, that’s OK because you can enter bulk time. Just go to the next step to 
learn how to enter bulk time. To add or edit time entries recorded using the Timer, use the 
Timesheet view instead of the Bulk Time view to edit those days (see page 35). 

 

Step 1.5 - Using the Bulk Time view 
The Bulk Time view is a grid type form, which enables you to enter time for an entire 
week. Use it to quickly distribute time across multiple days or projects or use it to 
copy/paste past weekly time entries for a new week. Let’s learn how to enter time 
using this view.  
 

Go to the Bulk Time view (click  button on the side shortcut bar). 
  

 
1. Select the Week ending date from the calendar. 

2. Click the Add button.   

3. Double-click any Task to add a row in the weekly grid, or click the Add All button. 
Click OK when done.  

 To start tracking time: 

 To stop tracking time: 

 To add time: 
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4. Enter the total hours worked in the appropriate box for the day. 

  

5. To quickly distribute hours worked for multiple days or projects, select the 
applicable rows and/or columns, right click and select Add Total Time from the 
menu. 
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6. Enter the Total hours worked. 

7. Click OK when done. 

 

 

1. Click the Bulk Time button  on the side shortcut bar if you’re not already 
there. 

2. Select the date from the Week ending box. HINT: Click the red circle to 
automatically select today’s date. 

3. Select one or more boxes to copy, right click and select Copy. 

4. Select the first box to paste, right click and select Paste. 

 
Important information: 
 

 You do not need to select the same number of boxes to paste. Simply select 
the first box to paste. 

 If you’ve selected time entries across multiple days, they will be copied to 
following days but will not go beyond the displayed week. 

 Time entries entered in this view can only be edited if they have not been 
submitted to Track-IT. Time entries for days that have been submitted will 
appear in a different color. 

 To edit time entries that have been entered from the Timer view, it is advisable 
to use the Timesheet view instead of the Bulk Time view as time entries will be 
rolled up when edited in the Bulk Time view.  

 
Time entries can also be viewed in more detail from the Timesheet view. The next step 
explains how to use this view. 

 

 To copy/paste time: 
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Step 1.6 – Add or edit time entries 
Time entered using the Timer or Bulk Time views can be edited in the Timesheet view. 
From there, you can also add any entries you may have forgotten. So let’s learn how to add 
and edit time entries in the Timesheet view. 
 

Go to the Timesheet view (click  button on the side shortcut bar or, to edit a 

particular day, double click the day in the Calendar view ). 

 

1. Click the Add button . 

2. Select the timesheet entry Date from the calendar. 

3. Enter the total number of hours in the Duration box (or you can enter Start and 
End times). 

4. Select the Task from the list and a Description (optional). 

5. Click OK when done. 

 To edit, select a row and double-click to edit accordingly. 

 To delete, select a row and click the Delete button . 
 
 
THAT’S GREAT, YOU’VE SUCCESSFULLY COMPLETED THE FIRST STEP 
 
Now: 

 Track the time that you spend working on your projects and tasks for a day. 

 At the end of the day, go to the second step to learn how to view and print reports. 

If you have problems, select Help, Contents in Track-IT light for help on particular 
options or functions or use the What’s this Help for help on items on any view (click 

the button on the toolbar then click any item). 
 

Good luck and see you tomorrow!  

 To add: 
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Step 2.1 - Print reports & graphs 
Now that you’ve entered your time for a day, you’re ready to analyze the information. First, 
print your reports and graphs: 

1. Select a report or graph from the Reports menu. 

2. Click the Date Range button  to select the reporting period. 

3. Click the Print button . 

4. Redo steps 1 to 3 to view or print other reports or graphs. 

 

Step 2.2 - Analyze the information 
Looking at your reports and graphs, ask yourself a few important questions: 

1. Did I achieve my targets? 

2. Did I spend too much time on certain tasks? 

3. Is my time spent on the best priorities? 

4. What work habits do I need to change? 

5. What are my new targets? 
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Step 2.3 - Enter new targets 
Enter your new targets in Track-IT light. 

 
1. Go to View, Target Information. 

2. Select a Project from the list. 

3. Edit Target information at the bottom of the pop up box. 

4. Redo steps 2 and 3 for the other projects. 

5. Click OK. 

 

YOU’VE SUCCESSFULLY COMPLETED THE SECOND STEP 
 
Now, 
 
1. File the printed reports and graphs in a safe place until we reach step 3. 

2. Track your time for another day. 

3. After tracking your time for a day, go to the 3rd and final step. 

If you have problems, select Help, Contents in Track-IT light for help on particular 
options or functions or use the What’s this help for help on items on any view (click 

the  button on the toolbar then click any item). 

Good luck and see you tomorrow!  
 
 
Step 3 - Final step 
Now, examine your improvements. 

1. Print or view your reports or graphs: 

a. Select a report or graph from the Reports menu. Click the  button to change 
the reporting period. 

b. Click  to print. 

 To enter targets: 
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c. Compare this report or graph with the one printed yesterday. 

2. Are your targets closer to reality than the previous graph? 

3. To submit your timesheet information to Track-IT, click . 

 
The most important principle of time management is to realize what your priorities are 
and to ensure that you are working towards them. If your targets are closer to reality, 
WOW, YOU DID IT!   
 
CONGRATULATIONS, you’re on your way to better time management. All you need to do 
now is keep tracking your time and make sure you print or view your graphs on a 
regular basis. 
 
And remember, good time management starts with using the right tools...  Good luck 

and most of all, have fun!   
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Timer view  
Track-IT light offers three easy ways to enter time (1) Timer (2) Bulk Time and (3) 
Timesheet. Use the Startup view tab in Tools, Options, to select one view and Track-IT 
light will automatically go to your preferred view when it starts. Here, we will discuss 
how to use the Timer view. 
 
With the click of a mouse, this innovative tool eliminates the labor and takes the 

guesswork out of time keeping. Use the Timer view  to track time as you work 
(like a stopwatch). 
 

All time entered is saved in this Timesheet view . From the Timesheet view, you 
can add, edit and delete time entries entered using the Timer. It shows detailed time 
entries for any date range. Quickly go to the Timesheet view to edit any day. Simply 

double click any day in the Calendar view  to display the Timesheet view for 
that day. 
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Understanding the Timer toolbar 
 
In addition to keyboard shortcuts for the menu actions, Track-IT light offers one-step 

access to commonly used actions through buttons on the Timer  toolbar. 
Frequently used actions are right at hand when you need them. The toolbar appears at 
the top of the view. Click the button once to turn it on. 
 
 

 
 
 

  To Start tracking time as of now on the selected item in the Tracking List or 
Priority Tracking List. When tracking is stopped, the timesheet entry is moved to 
the Timesheet view and you can edit it if necessary. (Menu command: Actions, 
Start) 

 

  To Start tracking time from the end time of the previous timesheet entry or as 
of the default start time set in Preferences (see “My day starts at” in Tools, 
Options). If no previous timesheet entry was made for today, and the current 
time is prior to your set default start time, the “start from last” will be disabled. 
(Menu command: Actions, Start from Last) 

 

  To Stop tracking time. Once tracking is stopped, the timesheet entry is moved 
to the Timesheet view for editing if necessary (see also Auto stop/start. (Menu 
command: Actions, Stop) 

 

  To Detail or Shrink the Timer view. Shrink will only work when tracking is ON. 
(Menu command: Actions, Shrink) 

 
  This button is used to Submit your timesheet. (Menu command: Actions, 

Submit Time & Expense Entries) 
 

  This button is used to Refresh your project and task list. (Menu command: 
View, Refresh) 

 

  To display the Help table of contents. You can also use the What’s this Help 
for help on items on any view (click the  button on the toolbar then click any 
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item) or search for a topic using the Help option in the menu. (Menu command: 
Help, Contents) 

 
 

 

1. Select View, Timer (or click the Timer button  on the side shortcut bar) 
if you’re not already there. 

 

   

 To start the timer: 
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2. Select the Task name from the list. 

3. Enter a Description if required. 

4. Click the Start  or Start from Last  buttons. 

 The Start from Last button  will start tracking according to the end 
time of the previous timesheet entry. 

 If the previous timesheet entry was recorded prior to today, the Start 

from Last  will use the default time entered in Tools, Options, My 
day starts at. 

 If Auto-shrink is ON, when you click on Start  or Start from last , 
the view will then shrink and remain on top of any open application. Go to 
Tools, Options, Automatic Options, to turn Auto-shrink ON or OFF. 

 To maximize the view, click the Detail/Shrink button . The software 
will keep tracking either way. 

 If you want to enter time against a project that you’ve removed from the 
list, select Actions, Display All Items from the menu. 

 You can also remove items from your list of available projects/tasks by 
using View, Target Information. 

5. Select the Charge to Client option if the time transaction is billable or 
deselect this option if it’s non-billable. 

6. If required, select the appropriate Overtime Rates. 

7. Click the Custom Fields tab and enter Custom field information if required. 
(See page 19) 

 
Tasks not being displayed? 
If Tasks are no longer being displayed or are not displayed in all views (Timer, 
Timesheet, Bulk Time), the Track-IT manager may have configured the task to 
prevent entries outside specific start and end dates. See Show Only Current 
Assignments on page 20 or contact your manager for more information. 
 
 

 
1. Click the Stop button.    

 

 To stop the timer: 
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 If the view is shrunk, the Timer view will be automatically restored. The 

recorded time will move to the timesheet (click the Timesheet button  
on the side shortcut bar) and the start and end times in the main view will 
reset, ready to start tracking again. 

2. Select another task and click Start  or Start from last  to start tracking 
for your new selection. 

 
 If Auto stop/start is ON, you do not need to click stop. While tracking is ON, 

simply select another task. The software will stop tracking, store the recorded 
timesheet entry and start tracking for the new selection. 

 If Auto stop/start is ON and you want to allocate the current time worked to 
a different item, press the shift key while making your selection. 

 If Auto stop/start is OFF, press the shift key while making your selection 
when you’re tracking time and it will automatically start tracking for the new 
selection. 

 Use your mouse to drag and drop items from your Tracking List to your 
Priority Tracking List for frequently used categories. Use the Priority 
Tracking List to track time in the same manner described above. To remove 
items from your list, select Actions, Clear Priority Tracking List from the 
menu. 

 
 
 
Task Progress Statistics  
In the Timer view, Task Progress information is displayed in the right pane. This 
information displays a task’s progress against budgeted time and the timesheet entry 
tool user’s estimate. 

 

Click on a task to display its Task Progress information. If a task is a global task then 
“No Estimate information available for this Task.” appears. If there is no budgeted 
information for a task (assigned in Track-IT pro or Track-IT pro web), then the Start 
and Finish dates are displayed but the calculations show N/A (Not Applicable). 

 

Task Progress description 

 The task’s scheduled Start and Finish dates. The Task start and finish dates 
can be changed in the Project Budgets and Gantt views in Track-IT pro (and 
Track-IT pro web. 
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 Actual hours entered / Budgeted hours. Displays the Actual hours worked 
against the Budgeted hours that it would take to complete the task. The 
result shows the % completed based on the Actual and Budgeted hours. 
Note that Budgeted hours are entered in Estimated Hours within the Project 
Budgets view of Track-IT pro or Track-IT pro web. 

 Displays the employees % Complete entered in the Estimates view of 
Track-IT light. Changes made to the % Complete are sent to Track-IT. 
Changes made in the Budgeted hours will automatically update the % 
Complete entered. 
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Bulk Time view  
 
Track-IT light offers three easy ways to enter time (1) Timer (2) Bulk Time and (3) 
Timesheet. Use the Startup view tab in Tools, Options, to select one view and Track-IT 
light will automatically go to your preferred view when it starts. Here, we will discuss 
how to use the Bulk Time view. 
 

Enter your total hours worked for the day or week in the Bulk Time view . This 
weekly grid lets you quickly distribute hours worked across one or more days or 
projects. Use it to copy and paste work from previous weeks or to edit timesheet 
information. This view shows rolled up time entries per project and tasks for each day 
of the week. 
 

Understanding the Bulk Time toolbar 
 
In addition to keyboard shortcuts for the menu actions, Track-IT light offers one-step 

access to commonly used actions through buttons on the Bulk Time  toolbar. 
Frequently used actions are right at hand when you need them. The toolbar appears at 
the top of the view.  
 

 
 
 

  To save the timesheet. (Menu command: File, Save) 

Chapter 
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  To print the timesheet. (Menu command: File, Print) 
 

  To add a timesheet entry. (Menu command: Edit, Add Row) 
  

  To delete a timesheet entry. (Menu command: Edit, Delete Selected Cells). You 
can also use “Delete Row” from the Edit menu to delete all entries for a row. 

 

 To hide a row. Once a row has been hidden, you can create a new row filter to 
save your current configuration so you can display only those specific rows each 
time you enter the bulk time view.  

 
  To submit your time and expenses. (Menu command: Actions, Submit Time & 

Expense Entries) 
 

  To display the Help table of contents. You can also use the What’s this Help 
for help on items on any view (click the  button on the toolbar then click any 
item) or search for a topic using the Help option in the menu. (Menu command: 
Help, Contents) 

 
You can add or edit time entries for any day in this view until they have been 
submitted to Track-IT. Days that have been submitted are marked in yellow (see 
image below). You can however add new entries for those days from the Timesheet or 
Timer views. 
 
 

 
This is a screen shot of the Bulk Time view. Notice that for Friday, Aug 29, the day is highlighted 
in yellow. This day cannot be edited from this view because the time entries have been 
submitted. 
 

Note: If you edit a day where time entry was done using the Timesheet or Timer 
views, time entered will be rolled up (i.e. if you have two time entries for the same 
project and task, it will be rolled up into one). Time entries for the day will start at 
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the time specified in your “my day starts at” setting, overwriting any specific “start” 
and “end” times entered. 

It will also roll up multiple entries for the same Project/Task for that date. The 
effect can be the loss of individual Custom Field and Description data. 

Hint: Use the Auto-display projects and tasks to view (or hide) previously used 
projects and tasks. 

 

 

1. Select View, Bulk Time from the menu (or click the Bulk Time button  on 
the side shortcut bar). The Bulk Time view will be displayed. 

 

  

 
2. Select the Date from the Week ending box. 
 

 Click the red circle to automatically select today’s date. 

3. Click the Add button  on the top toolbar (or select Edit, Add Row from the 
menu, or right click and select Add Row). A pop-up box will be displayed. 

 To enter a time entry or distribute time over multiple days/projects: 
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4. Select the task from the list and double-click the task to add a new row in your 
weekly timesheet grid. Double click any other item to add as many rows to the grid 
or click the Add All button to add all items. Click OK when done.  

5. In the weekly grid, enter the total number of hours worked in the appropriate 
white box corresponding with the project/task. 
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6. As shown below you can enter additional information for the time entry in the lower 
half of the view, this includes Descriptions, Client Overtime Rate, Overtime 
Rate and Custom Fields. 

 

7. To quickly distribute hours across multiple days or projects, add the appropriate 
rows to your worksheet (steps 3 and 4 above), select the applicable cells, right 
click and select Add Total time from the menu.  

  
 

8. Enter the Total hours worked. 

9. Click OK when done. 
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Tasks not being displayed? 
If Tasks are no longer being displayed or are not displayed in all views (Timer, 
Timesheet, Bulk Time), the Track-IT manager may have configured the task to 
prevent entries outside specific start and end dates. See Show Only Current 
Assignments on page 20 or contact the project manager for more information. 
 
 
 
Task Progress Statistics  
In the Bulk Time view, Task Progress information is displayed in the bottom pane. 
This information displays a task’s progress against budgeted time and the timesheet 
entry tool user’s estimate. 
 
Click on a task to display its Task Progress information. If a task is a global task then 
“No Estimate information available for this Task.” appears. If there is no budgeted 
information for a task (assigned in Track-IT pro or Track-IT pro web), then the Start 
and Finish dates are displayed but the calculations show N/A (Not Applicable). 
 

Task Progress description 

 The task’s scheduled Start and Finish dates. The Task start and finish dates 
can be changed in the Project Budgets and Gantt views in Track-IT pro (and 
Track-IT pro web). 

 Actual hours entered / Budgeted hours. Displays the Actual hours worked 
against the Budgeted hours that it would take to complete the task. The 
result shows the % completed based on the Actual and Budgeted hours. 
Note that Budgeted hours are entered in Estimated Hours within the Project 
Budgets view of Track-IT pro or Track-IT pro web. 

 Displays the employees % Complete entered in the Estimates view of 
Track-IT light. Changes made to the % Complete are sent to Track-IT. 
Changes made in the Budgeted hours will automatically update the % 
Complete entered. 

 
 

 To edit a time entry: 
 

1. Select View, Bulk Time from the menu (or click the Bulk Time button  on 
the side shortcut bar) if you’re not already there. 

2. Select the Date from the Week ending box. 
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 Click the red circle to automatically select today’s date. 

3. Go to the appropriate box and edit the time entered. 

 You can add or edit time entries for any day in this view until they have 
been submitted to Track-IT. Days that have been submitted are marked 
in yellow. You can however add new entries for those days using the 
Timesheet or Timer views. 

 If you edit a day where time entry was done using the Timesheet or 
Timer views, time entered will be rolled up (i.e. if you have two time 
entries for the same project and task for the day, it will be rolled up into 
one), and time entries for the day will start at the time specified in your 
“my day starts at” setting. This will overwrite any specific “start” and 
“end” times entered. 

 

 

1. Select View, Bulk Time from the menu (or click the Bulk Time button  on 
the side shortcut bar) if you’re not already there. 

2. Select the Date from the Week ending box. 

 Click the red circle to automatically select today’s date. 

3. Select one or more boxes to delete. 

4. Right click and select Delete Selected Cells to delete all entries in the selected 
boxes or simply enter 0 in the appropriate box. 

 Deleted items cannot be recovered. 

5. To delete a row, select the row and right click to select Delete Row. When you 
delete a row, it will only delete time entries for the displayed week. 

 When you delete a row, it does not delete projects or tasks, only time 
entries displayed in the current week. 

 You can only delete one row at a time. If you have more than one row 
selected, the row marked in bold is the one, which will be deleted (see  
image below). 

 To delete a time entry: 
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 In this case, the “Fre-Development: Testing” row is the one that will be deleted. 
 

 
1. Add the rows that you would like to be able to display each time you open the 

Bulk Time view. 

• You can add a row using the “Edit, Add Row” menu command or you can hide rows by 
using the “Edit, Hide Row” command.  

 
2. Click New, enter a Name for the filter and select OK. 

• You can delete a filter by selecting the remove button or edit the filter by 
adding/hiding rows and selecting Save.  

 
 

 

1. Select View, Bulk Time from the menu (or click the Bulk Time button  on 
the side shortcut bar) if you’re not already there. 

2. Select the Date from the Week ending box. 

 Click the red circle to automatically select today’s date. 

3. Select one or more boxes to copy, right click and select Copy. 

4. Select the first box to paste, right click and select Paste. 

 You do not need to select the same number of boxes to paste. Simply 
select the first box to paste. 

 If you’ve selected time entries across multiple days, they will be copied to 
following days but will not go beyond the displayed week. 

 To create a Row Filter: 

 To copy/paste a time entry: 
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Timesheet view 
Track-IT light offers three easy ways to enter time (1) Timer (2) Bulk Time and (3) 
Timesheet. Use the Startup view tab in Tools, Options, to select one view and Track-IT 
light will automatically go to your preferred view when it starts. Here, we will discuss 
how to use the Timesheet view. 

All time entered is saved in this Timesheet view . From this view, you can add, 
edit and delete time entries entered using the Timer or Bulk Time views. It shows 
detailed time entries for any date range.   
 
Quickly go to the Timesheet view to edit any day. Simply double click any day in the 

Calendar view  to display the Timesheet view for that day. 
 

Understanding the Timesheet toolbar 
 
In addition to keyboard shortcuts for the menu actions, Track-IT light offers one-step 

access to commonly-used actions through buttons on the Timesheet  toolbar. 
Frequently used actions are right at hand when you need them. The toolbar appears at 
the top of the view.   

 
 

  To save the timesheet. (Menu command: File, Save) 
 

Chapter 
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  To print the timesheet. (Menu command: File, Print) 
 

  To add a timesheet entry. (Menu command: Edit, Add Time Entry) 
  

   To edit a timesheet entry. (Menu command: Edit, Edit time Entry) You can also 
double click or use the Enter key to edit a row. 

 

  To delete a timesheet entry. (Menu command: Edit, Delete). You can also use 
“Delete All” from the Edit menu to delete all timesheet entries displayed in your 
timesheet. 

 

  To Show or Hide time entries that have not been sent. (Menu command: 
Actions, Show Entries by Status, Unsent) 

 

  To Show or Hide time entries that have been sent but are currently under 
review. (Menu command: Actions, Show Entries by Status, Under Review) 
 

 To Show or Hide time entries that have been rejected. (Menu command: 
Actions, Show Entries by Status, Rejected) 

 

 To Show or Hide time or expense entries that have been approved. (Menu 
command: Actions, Show Entries by Status, Approved) 

 

 Type text in any column of the first row to display only information matching the 
text entered. To remove the filter, click this button. (Menu command: Actions, 
Clear Filter) 

 
 Select this button to Hide/Show specific columns from view. A hidden column 

can always be displayed again. 
 
   To move to the first row. (Menu command: Actions, First) 
 
  To move to the previous row. (Menu command: Actions, Previous) 
 
  To move to the next row. (Menu command: Actions, Next) 
 
  To move to the last row. (Menu command: Actions, Last) 
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  To change the reporting period (From and To date range) displayed. (Menu 
command: Actions, Date Range) 

 
  This option is used to Submit your timesheet and expenses to Track-IT for 

approval. (Menu command: Actions, Submit Time & Expense Entries) 
 

  To display the Help table of contents. You can also use the What’s this Help 

for help on items on any view (click the  button on the toolbar then click any 
item) or search for a topic using the Help option in the menu. (Menu command: 
Help, Contents) 
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1. Select View, Timesheet from the menu (or click  button on the side 
shortcut bar). 

 

2. Click the Add button.  
 
Tip: Required fields in Track-IT light will appear with an asterisk (*) to the left of 
the field name and must be filled in. 

 
3. Select the timesheet entry Date from the calendar. 
 
4. Enter the total number of hours in the Duration box. 

 
 Instead of entering the Duration time, you can enter the Start and End 

times. 

5. Select a Project and Task from the list. 
 

 Type the first letter of the project name you’re looking for to quickly go to 
that project. 

6. Enter a Description if required. 
 
 7. If required, select the appropriate Overtime Rates. 

 
8. Click the Custom Fields Tab and enter custom field information if required. 

(See page 19) 
 

9. Click OK when done. 
 

 If you want to enter time against a project that you’ve removed from the 
list, click the Display All button at the bottom of the Add popup screen. 
You can also temporarily remove items from the display list. 

 
Tasks not being displayed? 
If Tasks are no longer being displayed or are not displayed in all views (Timer, 
Timesheet, Bulk Time), the project manager may have configured the task to prevent 

 To add time entries: 
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entries outside specific start and end dates. See Show Only Current Assignments on 
page 20 or contact your manager for more information. 
 
 
Task Progress Statistics  
Task Progress information is displayed in the Add Time entry screen. This 
information displays a task’s progress against budgeted time and the timesheet entry 
tool user’s estimate. 

 
Click on a task to display its Task Progress information. If a task is a global task then 
“No Estimate information available for this Task.” appears. If there is no budgeted 
information for a task (assigned in Track-IT), then the Start and Finish dates are 
displayed but the calculations show N/A (Not Applicable). 
 

Task Progress description 

 The task’s scheduled Start and Finish dates. The Task start and finish dates 
can be changed in the Project Budgets and Gantt views in Track-IT pro (and 
Track-IT pro web). 

 Actual hours entered / Budgeted hours. Displays the Actual hours worked 
against the Budgeted hours that it would take to complete the task. The 
result shows the % completed based on the Actual and Budgeted hours. 
Note that Budgeted hours are entered in Estimated Hours within the Project 
Budgets view of Track-IT pro or Track-IT pro web. 

 Displays the employees % Complete entered in the Estimates view of 
Track-IT light. Changes made to the % Complete are sent to Track-IT. 
Changes made in the Budgeted hours will automatically update the % 
Complete entered. 

 
 

 

1. Select View, Timesheet from the menu (or click  button on the side 
shortcut bar). 

 

2. Click the Edit button  (or double-click any row). 
 

3. Select the Date for the time entry from the calendar. 
 

 To edit time entries: 
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4. You can either edit Start and End times or the Duration. 
 

5. Select a Project and Task from the list. 
 

 Type the first letter of the Project name you’re looking for then highlight 
the task. 

 If you want to enter time against a project that you’ve removed from the 
list, click the Display All button at the bottom of the Add popup screen. 
You can also temporarily remove items from the display list. 

6. Enter a Description if required. 
 

7. If required, select the appropriate Overtime Rates. 
 
8. Click the Custom Fields Tab and enter custom field information if required. 

(See page 19) 
 
9. Click OK when done. 

 
 

 

1. Select View, Timesheet from the menu (or click  button on the side 
shortcut bar). 

 
2. Select the row. 

 You can use the buttons on the toolbar to quickly move to the first , next 
, previous  or last  row. 

3. Click  to delete the highlighted row. 
 
 

 To delete time entries: 
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Calendar view 
This month-at-a-glance view (see sample screen shot below) enables you to quickly 
review your time worked. Double click any day to add, edit or delete timesheet entries 

for the specific day. To return to the calendar view, click the Calendar button  on 
the side shortcut bar. 
 
Use the top toolbar buttons or right-click on your mouse to access the following 
functions: 
 

 
 

 Select All - To select all days in the calendar view. (Menu command: Edit, 
Select All) 

 

 Unselect All - To unselect all days in the calendar view. (Menu command: Edit, 
Unselect All) Or click any box to select one or more days. 
 

 Delete all - To delete all timesheet entries for the selected days. CAUTION: You 
cannot recover deleted items. (Menu command: Edit, Delete All) 
 

  This option is used to Submit your timesheet and expenses to Track-IT for 
approval. (Menu command: Actions, Submit Time & Expense Entries) 

 

 To display the Help table of contents. You can also use the What’s this Help 

for help on items on any view (click the  button on the toolbar then click any 
item) or search for a topic using the Help option in the menu. (Menu command: 
Help, Contents) 

Chapter 
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1. Click the Calendar button  on the side shortcut bar. 
 

  
 

2. Select the Month or Year located at the top of your view. 
 

   
 
 

 To change the month or year displayed: 
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Expenses view 
Use this detailed view to track expenses by project and expense category. This view 
allows you to enter expenses in a detailed format with the ability to view and print 
reports based on the expense information you enter. All expenses entered are saved in 
this view. From this view, you can add, edit and delete expense entries quickly and 
easily. It shows detailed expense entries for any date range. These expense entries 
can be submitted to Track-IT for approval. 

Quickly enter expenses by simply clicking the Expenses View . 
 

Understanding the Expenses toolbar 
 
In addition to keyboard shortcuts for the menu actions, Track-IT light offers one-step 

access to commonly-used actions through buttons on the Expense  toolbar. 
Frequently used actions are right at hand when you need them. The toolbar appears at 
the top of the view. Click the button once to activate the command. 
 
 
 

 

  To save an Expense. (Menu command: File, Save) 
 

 To add an expense entry. (Menu command: Edit, Expense Entry) 

Chapter 
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  To edit an expense entry. (Menu command: Edit, Edit Expense Entry) You can 
also double click or use the Enter key to edit a row. 

 

 To delete an expense entry. (Menu command: Edit, Delete). You can also use 
“Delete All” from the Edit menu to delete all entries displayed in your timesheet. 

 

 To Show or Hide entries that have not been sent. (Menu command: Actions, 
Show Entries by Status, Unsent) 

 

 To Show or Hide time entries that have been sent but are currently under 
review. (Menu command: Actions, Show Entries by Status, Under Review) 
 

 To Show or Hide entries that have been rejected. (Menu command: Actions, 
Show Entries by Status, Rejected) 

 

 To Show or Hide entries that have been approved. (Menu command: Actions, 
Show Entries by Status, Approved) 

 

 Type text in any column of the first row to display only information matching the 
text entered. To remove the filter, click this button. (Menu command: Actions, 
Clear Filter) 

 
 Select this button to Hide/Show specific columns from view. A hidden column 

can always be displayed again. 
 

  To move to the first row. (Menu command: Actions, First) 
 

 To move to the previous row. (Menu command: Actions, Previous) 
 

 To move to the next row. (Menu command: Actions, Next) 
 

   To move to the last row. (Menu command: Actions, Last) 
 

 To change the reporting period (From and To date range) displayed. (Menu 
command: Actions, Date Range) 
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  This option is used to Submit your time and expense entries to Track-IT for 
approval. (Menu command: Actions, Submit Time & Expense Entries) 

 

 To display the Help table of contents. You can also use the What’s this Help 

for help on items on any view (click the  button on the toolbar then click any 
item) or search for a topic using the Help option in the menu. (Menu command: 
Help, Contents) 

 

1. Select View, Expenses from the menu (or click  button on the side 
shortcut bar). 

 

2. Click the Add button.  
 

Tip: Required fields in Track-IT light will appear with an asterisk (*) to the left of 
the field name and must be filled in. 
 
3. Select the expense entry Date from the calendar. 
 
4. Select the Project for the Expense from the drop-down list. 
 
5. Select the Expense Category. (Optional) 

 
6. Enter a Purchase Order number. 
 
7. Enter a Reference Number for the expense. (Optional) 
 
8. Enter the Amount for the expense. 
 
9. Select Request Reimbursement if you wish to be reimbursed for this 

expense. 
 

10. Select Charge to Client if the expense is Billable or deselect this option if it is 
Non-Billable. 

 
11. Enter a Markup Percent for the expense if required. The Markup Percent is 

multiplied by the Amount and added to the Fixed Amount to determine the 
Client Cost. Client Cost = (Amount x Markup) + Fixed Amount. 

 
12. Enter a Fixed Amount if required. 

 To add expense entries: 
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13. Enter the Value Added Tax 1 and Value Added Tax 2 for your location if 
required. 

 
14. Enter a Description if required. 
 
15. Click the Custom Fields Tab and enter custom field information if required. 

(See page 19) 
 
16. Click OK when done. 

 
 

 

1. Select View, Expenses from the menu (or click  button on the side 
shortcut bar). 

 
2. Select the row in the expense list. 

 

3. Click the Edit button  (or double-click any row). 
 
4. Make any necessary changes to the expense information. 

 
5. Click OK when done. 
 

 

1. Select View, Expenses from the menu (or click  button on the side 
shortcut bar). 

 
2. Select the row. 

 
 You can use the buttons on the toolbar to quickly move to the first , 

next , previous  or last  row. 

3. Click  to delete the highlighted row. 
 
 

 To edit expense entries: 

 To delete expense entries: 
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Estimates view 
This Estimates view enables you to quickly enter the Percentage Completed for any 
project currently assigned. This enables a manager using Track-IT pro or Track-IT pro 
web to view and print estimated time to completion reports to aid in tracking project 
development and employee efficiency. The Estimated Start and Finish dates are also 
displayed as are the Actual Hours per Task. 

Quickly enter expenses by simply clicking the Estimates View  
 
 

 

1. Select View, Estimates from the menu (or click  button on the side 
shortcut bar). 

 
2. Select the Project from the drop-down list or select Show All Projects. 
 
3. Enter the Percent Completed in the % Complete column for the appropriate 

project. Note that the % Complete can only be modified if the project/task has 
an estimate entered against it by the project manager using Track-IT pro or 
Track-IT pro web. 

 
4. Click OK when done. 
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 To add an Estimate: 
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1. Select View, Estimates from the menu (or click  button on the side 
shortcut bar). 

 
2. Select the Project from the drop-down list or select Show All Projects. 
 
3. Edit the Percent Completed in the % Complete column for the appropriate 

project. 
 
4. Click OK when done. 
 
 
 

 

 To edit an Estimate: 
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Submit timesheet 
When you select this option, the hours worked, expenses and estimates for the date 
period selected will be sent to Track-IT. 
 

 Once the timesheet entries have been sent, they will no longer be available for 
editing using Track-IT light. 

 In the Timesheet view , rows with the  icon have been submitted and 
can no longer be edited. Rows that have been approved in Track-IT will be 

marked with the following icon . Rows with the  icon are rejected and 
must be edited (see instructions below on how to edit). 

 In the Bulk Time view , days that have been sent will be displayed in a 
different color. 

Before submitting your time information to Track-IT, you may want to edit and print 
your timesheet and reports as explained in steps A and B below. Otherwise, go to step 
C. 
 
 

1. Select View, Timesheet view (or click  on the side shortcut bar). 
 

2. Click  to change your reporting period. 
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 Step A – To edit and print your timesheet: 
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3. Edit your timesheet. 
 

4. Select Print from the File menu if you want to print or click . 
 
 

 
1. From the Reports menu, select a report. 

 

2. To change the reporting period, click the Date Range button  and select 
the From and To date range. Click OK when done. 

 

3. Select File, Print from the menu to print or click. . 
 
 

 

1. Select Actions, Submit Time & Expense Entries from the menu or click . 
Any day with less or more then the required amount of time per day will be 
displayed in the Time entry screen at the bottom of the Submit Time / Expense 
Entries window. To edit an entry simply select the entry and click the Edit 
button. 

 

 Step B – To view and print reports & graphs: 

 Step C – To submit your timesheet: 
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2. Select Submit Time Entries. 

3. Edit the Title if required. If no title is entered, the submitted sheet’s title will 
still include the type of submission (time or expense), the submitter’s name 
and the date range. 

4. Select the From and To dates from the drop down calendars.  

5. If you have expense entries that you would like to submit, simply repeat the 
above steps for the Submit Expense Entries section. 

6. Click the Submit button to send entries. 

 A message will be displayed "Time entries have been Submitted to Track-
IT". Click OK to return to the previous view. All timesheet and expense 

entries submitted will be marked with an icon (  or ) in the Timesheet 
view. You can no longer edit submitted time/expense entries.   
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Reports / Graphs  
1. Click the Reports button on the top toolbar. 
 
2. Select the report from the list. 
 

3. To change the reporting period, click the Date Range button  and select a 
From and To date range. Click OK when done. 

 

4. Select File, Print to print the displayed report or graph or click . 
 
 

Chapter 
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Report types 
 

 TOTAL HOURS WORKED BY PROJECT AND TASK: Is a report showing the 
total hours worked in hours and in percent and also the target entered by 
project and task. 

 
 % OF TOTAL HOURS WORKED BY PROJECT (including target): Is a 

graph showing the percent in time of the total hours worked and the targets. 

 
 % OF TOTAL HOURS WORKED BY PROJECT: Is a pie chart showing the 

percent in time of the total hours worked for each project. 

 
 % OF TOTAL HOURS WORKED BY TASK: Is a pie chart showing the 

percent in time of the total hours worked for each task. 

 EXPENSES BY PROJECT: Displays a list of expenses for the specified data 
range.  
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Track-IT web edition 
Track-IT web edition is an on-line web based application. It is used by off-site or office 
workers over the Internet or an Intranet. The application can be installed locally on 
your network, providing great flexibility in how you wish to use the application.  
 
This state-of-the art system is able to synchronize with Track-IT on your server. This 
unique feature allows employees to enter time and expenses from anywhere in the 
world using any web browser, while allowing you to keep control of your data and 
ensuring that sensitive cost, client and employee information is kept secure. As with 
Track-IT light, simply select the project and task and enter the total time worked.  
 
Track-IT web edition provides performance information (in report format) and 
compares it to your goals. It uses a Microsoft n-tiered architecture for high 
performance and great scalability. Application processing, business processing, and 
database processing can be separated/combined, as needed depending upon your 
company’s needs. For more information on Track-IT web edition and to view screen 
shots, go to: http://www.dovico.com/products.html. 

System requirements and installation 
 
Please refer to the Step-by-Step for Track-IT Suite guide that was sent to you by 
e-mail, or with the packaged software, or download it from our web site at 
http://www.dovico.com/client.html. 
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What you need to know 
Projects and Tasks are used to identify what you are tracking. Project and task names are 
entered in Track-IT pro or Track-IT pro web. 

Projects: A project or process, the subject of a task (administration, production, 
sales, etc.). 

 

 

Tasks: A task or activity (telephone, meeting, travel, etc.). Tasks are actions to 
be performed for each project. Multiple tasks are assigned to each 
project for time tracking purposes. You can create as many sub-tasks as 
necessary. 

 

 
 

To access Track-IT web edition Help, click the Help button . 

 

 

1. Start your web browser. 

2. Enter the URL (example https://www.dovico.net/tweb) or if Track-IT web 
edition has been installed locally on your network, then enter the URL address 
designated by your system administrator in the browser’s URL address box.  

3. When the Login page is displayed, select a database, and enter your User ID 
and Password.. 

 

 
 

 To start Track-IT web edition: 
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Time & Expense entry 

 
Understanding the toolbar 
 
Frequently used commands are right at hand when you need them. The Toolbar 
appears at the top of your Internet Browser. Click the button once to activate the 
command. 
 
 
 

 
 

 The Timer view allows you to track your time as you work (like a 
stopwatch), or enter time as a total. 

 

 The Bulk time view allows you to quickly enter large amounts of time in a 
weekly timesheet grid. 

  The Expenses view allows you to add, edit or delete expenses. It 
supports Billable Time, Request For Reimbursement as well as Expense 
Categories. 

  Track-IT web edition has an Estimates view where an employee can view 
the Actual and Estimated hours for an assignment and enter the 
percentage complete for an assignment. Track-IT web edition allows you to 
enter an estimated % complete on an assigned task. This allows you to 
inform your administrator or manager the current status of this particular 
assignment, so they will know if the project is on track or not. 

 The Reports view gives you the ability to view detailed reports on your 
time and expense information. 

  The Submit view is used to send timesheets and expenses to Track-IT. 

    The Options view is used to view and change your personal preferences. 
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  To access Help for Track-IT web edition. 
 

  To Logout of Track-IT web edition. 
 

 To access Track-IT web edition’s home page. 
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Track-IT web edition Security 
Security can be applied to Track-IT web edition by granting and restricting access to menu 
items, views, and time tracking operations. Security can be applied to specific employees or 
groups of employees in Track-IT pro or Track-IT pro web by modifying the employee(s) 
security group. 

If you are attempting to access a particular view that has been restricted, a message box 
will be displayed stating “Access Denied”. For example, if access was restricted from the 
bulk time view then the following message would be displayed when the Bulk Time view 
button is selected. 
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Using the Timer view 
Track-IT web edition offers two easy ways to enter time (1) Timer (2) Bulk Time. Use 
the Options view to select the default view and Track-IT web edition will automatically 
go to your preferred view when you login.  
 
Here, we will discuss how to use the Timer view. 
 
With the click of a mouse, this innovative tool eliminates the labor and takes the 

guesswork out of time keeping. Use the Timer view  to track time as you work 
(like a stopwatch) or simply enter the duration of the time entry for quick timesheet 
entry. 
 
 

1. Select the Timer  button. 

2. Select the Project name from the drop-down list. 

3. Select the Task name from the drop-down list. 

4. Select the Overtime rate. (Optional) 

5. Select the Charge to Client option if the time entry is billable. 

6. Select the Client overtime rate. (Optional) 

7. Enter a Description if needed.  

8. Select the Custom Fields tab and enter custom field information if required. 
(See page 19) 

9. Click the Start  button. 
 
 

 

1. Click the Stop  button. 
 
 

 To start time tracking using the timer: 

 To end time tracking using the timer: 
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1. Click the Date icon  and select a date.  

2. Select the Project name from the drop-down list. 

3. Select the Task name from the drop-down list. 

4. Enter Start and End times or enter the Duration. 

5. Select the Overtime rate. (Optional) 

6. Select the Charge to Client option if the time entry is billable. 

7. Select the Client overtime rate. (Optional) 

8. Select the Custom Fields tab and enter custom field information if required. 
(See page 19) 

9. Click Save (on the Data tab). 
 
 

 

1. Click the Date for the time entry in the timesheet. 

2. Make any necessary changes to the time entry. 

3. Click Save. 
 
NOTE: Any time entry that has been submitted to Track-IT cannot be edited and will 

display  or  to the left of the time entry. 
 
 

 

1. Select the check box for the time entry that is to be deleted.  

2. Click the Delete button. 
 
 
 
 

 

 To enter time manually without starting the Timer: 

 To edit a time entry: 

 To delete timesheet entries: 
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1. Select the Reports  button. 

2. Select the Date range in the From and To text boxes. 

3. Select the Timesheet Report option. 

4. Click Preview. 

5. To print the report select File, Print from the menu in you web browser.  

 To print timesheet entries: 
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Using the Bulk Time view 
Enter your total hours worked for the day or week in this view. This weekly grid lets 
you quickly distribute hours worked across one or more days or projects. This view 
shows rolled up time entries per project and task for each day of the week. 
 

1. Select the Bulk Time button. 

2. Click the Date icon  and select a date (This will select 7 days ending with 
the date you specify). 

3. Click Refresh. 

4. Select the Project name from the drop-down list. 

5. Select the Task name from the drop-down list. 

6. Enter the Total hours for each day in the appropriate text boxes. 

7. Optionally click the Details button  and enter a Description and Custom 
field information and click Save. 

8. Click Save on the Bulk Time view. 
 
 

 

1. Select the From date from the drop-down list and click Refresh. (This will 
select 7 days ending with the date you specify). 

2. Click Refresh. 

3. Edit the Total hours for each day in the appropriate text boxes. 

4. Click Save. 

 
 
 
 
 

 To enter time in the Bulk Time view: 

 To edit time in the Bulk Time view: 
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1. Click the Date icon  and select a date (This will select 7 days ending with 
the date you specify). 

2. Click Refresh. 

3. Delete the Total hours for each day in the appropriate text boxes or select 
the Delete check box to delete time for that task for the entire week.  

4. Click Save. 
 

Note: Any time that has been submitted to Track-IT cannot be edited.  
  

Important: Editing time information within the Bulk Time view affects the Start 
and End times for your previous time entries. If you do not wish to have start and 
end times affected, enter time though the Timer View. It will also roll up multiple 
entries for the same Project/Task for that date. (i.e. if you have two time entries for 
the same project and task, it will be rolled up into one). The effect can be the loss of 
individual Custom Field and Description data. 

 

 To delete time in the Bulk Time view: 
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Submit Time & Expenses 
 
When you select this option, the hours worked for the displayed reporting period will 
be submitted to Track-IT. All timesheet entries that have been submitted will be noted 
as sent in the status column. 
 

 Once the timesheet entries have been sent, they will no longer be available for 
editing using Track-IT web edition. 

 
 When timesheets are submitted to Track-IT, any expense entries for the specified 

date can also be sent. 
 
 

1. Select the Submit  button. 

2. Select the Submit time entries option. 

3. Optionally enter a Title for the timesheet. If no title is entered, the 
submitted sheet’s title will still include the type of submission (time), the 
submitter’s name and the date range. 

4. Select the date range in the From and To text boxes. 

5. Click Refresh to update the page and view the time and expenses that will 
be sent to Track-IT. 

6. Click Submit. 
 
 

1. Select the Submit  button. 

2. Select the Submit Expenses option. 

3. Optionally enter a Title for the Expenses.  If no title is entered, the 
submitted sheet’s title will still include the type of submission (expense), the 
submitter’s name and the date range. 

4. Select the date range in the From and To text boxes. 

 To submit your Timesheet to Track-IT: 

 To submit your expenses to Track-IT: 
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5. Click Refresh to update the page and view the time and expenses that will 
be sent to Track-IT. 

6. Click Submit. 
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Using the Expenses view 

 
Expense entries entered in Track-IT web edition can be submitted to Track-IT when 
timesheets are submitted.. Once time and expense entries have been submitted to 
Track-IT they can no longer be edited within Track-IT web edition. 
 

1. Select the Expense button. 

2. Click the Date icon  and select the appropriate date. 

3. Select the Project from the drop-down list. 

4. Enter an expense Amount. 

5. Select the Expense Category from the drop-down list. (optional) 

6. Enter a Markup % (if applicable). The Markup % is multiplied by the 
Amount and added to the Fixed Amount to determine the Client Cost. 
Client Cost = (Amount x Markup) + Fixed Amount. 

7. Enter a Purchase order number (if applicable). 

8. Enter a Fixed amount (if applicable). 

9. Enter a Reference number. (optional) 

10. Enter a Value Added Tax. (optional) 

11. Select Charge to Client if the expense is billable (optional). 

12. Enter a second Value Added Tax. (optional) 

13. Select Reimbursement (If applicable). 

14. Enter a Description if needed. 

15. Select the Custom Fields tab and enter custom field information if required. 
(See page 19) 

16. Click Save (on the Data tab). 

 

NOTE: If the new expense is not visible in the expense list, please check the 
expense Date range. 

 

 To add an expense: 
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1. Select the Date for the corresponding expense in the expense list. 

2. Make any necessary changes to the expense. 

3. Click Save. 
 

NOTE: Any expense that has been submitted to Track-IT cannot be edited and will 

display  or  to the left of the expense. 
 
 

 

1. Select the check box for the Expense entry that is to be deleted. 

2. Click the Delete button for the corresponding expense in the expense list. 
 

 

1. Select the Reports  button. 

2. Select the date range in the From and To text boxes. 

3. Select the Expense Report option. 

4. Click Preview. 

5. To print the report select File, Print from the menu in you web browser. 
 
 

 To edit an expense: 

 To delete an expense: 

 To print an Expense report: 
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Using the Estimates view 
The Estimates view enables you to quickly enter the percentage completed for any 
project currently assigned. This enables a manager to view and print estimated time to 
completion reports to aid in tracking project development and employee efficiency. The 
Estimated Start and Finish dates are also displayed as are the Actual Hours per Task. 
 

1. Select the Estimates  button. 

2. Select a project from the drop down list. 

3. Enter the % Complete for the appropriate Project and Task. Note that the 
% Complete can only be modified if the project/task has an estimate entered 
against it from Track-IT pro or Track-IT pro web. 

4. Click Save. 
 
 

1. Select the Estimates button. 

2. Adjust the % Complete for the appropriate Project and Task.  

3. Click Save. 
 

 

 To enter estimates: 

 To edit estimates: 
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Using Options 
Use the Options view to view and change your personal preferences. These options 
make time entry easier and more efficient depending upon the preferences you 
choose. 

View or change your options by selecting the Options  button. 

 

Setting the timesheet date range: 

This will display all time entries for the selected date range in the Timer view. 

  

1. Select the appropriate date in the Timesheet from text box.  

2. Select the appropriate date in the Timesheet to text box.  

3. Click Save. 

 

Setting the expense date range: 

This will display all expenses for the selected date range in the Expenses view.  

  

1. Select the appropriate date in the Expense from text box.  

2. Select the appropriate date in the Expense to text box.  

3. Click Save. 

 

My Day Starts At  
The time entered in the My Day Starts At text box is used as the Start time for any 
time entered in the Bulk Time view or in the Timer view when no Start and End time 
is specified. This option should be set to the time you normally start working. Click 
Save after making the change. 

  
Detailed Timesheet view 
This option is used to Show/Hide the Start, End, Overtime Rate and Client Overtime 
Rate columns in the Timer view. Click Save after making the selection. 

 

http://www.dovico.com/webhelp/helpfile/add_edit_or_delete_expenses.html
http://www.dovico.com/help/webhelp/helpfile/using_the_timer.html
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Default View 

This option is used to set the view that you would like to be displayed when you login 
to Track-IT web edition. Click Save after making the change. 

 
  
Changing your Password 
To change your password, simply enter your new password in the Password and 
Confirm Password text boxes and click OK. The password will also be changed for 
all other Track-IT Suite components. 
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Reporting Options 
The following is a list of the reports that are included with Track-IT web edition: 

  
 Timesheet Report - This is a detailed timesheet report grouped by day. 

 
 Total hours worked by project and task - This report outlines an employee's 

total hours grouped by project and task. It includes Actual hours, Estimated 
Hours, Percentage of Total hours worked and Percent complete. 

 
 Total hours worked by task - This report outlines an employee's total hours 

grouped by task. It includes Actual Hours and Percentage of Total hours 
worked. 

 
 Expense Report - This is a detailed expense report grouped by day. It includes 

Reference Number, Amount and Description. 
 

 Expense By Project - This expense report is grouped by Project and Expense 
Category. It includes Category and Amount. 

 
 Expense By Category - This expense report is grouped by category. It includes 

Amount. 
 

 Accrual Results - This Accrual report displays accrued time. It includes 
adjustments. 

  

  

1. Select the Reports  button. 

2. Select the date range in the From and To text boxes. 

3. Select the Type of report to generate. 

4. Click Preview. 

5. To print the report select File, Print from the menu in you web browser. 

 To preview a report: 
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Show Only Current Assignments 
 
The Show Only Current Assignments function will hide tasks when the date is 
outside the task’s scheduled start and end dates. When properly configured by the 
project manager using Track-IT pro or Track-IT pro web, this function hides, from the 
Track-IT web edition user’s views, all those tasks that are not scheduled to be worked 
on. 
 

 In the Timer view: Only tasks that are scheduled to be worked on, within the 
Timer view’s date range, are displayed.  

 In the Bulk Time view: Only tasks that are scheduled to be worked on within 
the Bulk Time view’s date range are displayed. 

Task Progress Statistics 
 
Task Progress information is displayed in the Timer view and in the Bulk Time. This 
information displays a task’s progress against budgeted time and against the 
timesheet entry tool user’s estimate. 
 
If a task is a global task then “No Estimate information available for this Task.” 
appears. If there is no budgeted information for a task (assigned by the Project 
manager using Track-IT pro or Track-IT pro web), then the Start and Finish dates are 
displayed but the calculations show “N/A” (Not Applicable). 
 
In the Bulk Time view, click the Refresh button in the Task Progress box to get 
information on the selected cell. 
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Task Progress description 
 The task’s scheduled Start and Finish dates. The Task start and finish dates 

can be changed in the Project Budgets and Gantt views in Track-IT pro. 

 Actual hours entered / Budgeted hours. Displays the Actual hours worked 
against the Budgeted hours that it would take to complete the task. The 
result shows the % completed based on the Actual and Budgeted hours. 
Note that Budgeted hours are entered in Estimated Hours of the Project 
Budgets view in Track-IT pro or Track-IT pro web. 

 Displays the employees % Complete entered in the Estimates view of 
Track-IT web edition. Changes made to the % Complete are sent to Track-
IT. Changes made in the Budgeted hours will automatically update the % 
Complete entered. 
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Track-IT punchclock 
 
Track-IT punchclock is a Windows-based software used by production line workers. 
Traditional punch clocks usually require complicated setup, installation and servicing 
which can in turn be expensive. With very little setup, Track-IT punchclock will work 
on multiple computers throughout your business and allows for multiple user access. 
Each punch clock can track employee time under different projects and tasks. For 
more information on Track-IT punchclock and to view screen shots, go to: 
http://www.dovico.com/products.html   

System requirements and installation 
Please refer to the Step-by-Step for Track-IT Suite guide that was sent to you by 
e-mail, or with the packaged software, or download it from our web site at 
http://www.dovico.com/client.html 
 
Now, let’s follow these easy steps to setup Track-IT punchclock. 
 
 
 

 
1. From each employee workstation where punchclock will be used, start Track-

IT punchclock setup program from Windows Start, Programs, Track-IT 
Suite. A pop-up box will be displayed. 

 

Chapter 
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 To setup Track-IT punchclock: 

http://www.dovico.com/products.html
http://www.dovico.com/client.html
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2. Select the database from the drop-down list. If the database is located on 
another server, use the Browse button to search for the wcshosts.ini file. 

 
3. Click OK when done. 

 
Track-IT punchclock is now ready to be used. You can have as many people 
logging in and out at the same time from one or more locations as necessary. It’s 
easy as two clicks. Here’s how: 

 
 

 
1. Start Track-IT punchclock from the Start, Programs, Track-IT Suite menu. 

A pop-up box will be displayed. 
 

 

 To punch in and out: 
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2. Enter your User ID (this ID was entered in the Employees view of Track-IT 
pro or Track-IT pro web). 

3. Click Enter. 

  

4. Select the Project from the drop down list. 

5. Select the Task from the drop down list. 

6. Click Punch In. 

7. To punch out or for another employee to punch in, re-do steps 2 to 6. 

 
That's it! Employees are now tracking their time. Timesheet entries will be 
submitted to Track-IT for approval. 
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P A R T  I V  –  T E C H N I C A L  S U P P O R T  

Technical support 
 
Use the Web Resources option in the Help menu to access our web site for: time 
management articles, frequently asked questions (FAQs), knowledge base, developer’s 
site, technical support, e-mail support, and more… 
 
Or read the up-to-date information on our web site at 
http://www.dovico.com/techtips.html or use our on-line technical support request 
form at http://www.dovico.com/support.html 
 
To receive a Track-IT Suite update or to receive the latest version of this document, 
visit our web site at http://www.dovico.com/ 
 
Technical support: +1 (506) 855-4154 
Sales - North American toll free: 1-800-618-8463 
Sales – United Kingdom toll free:  +0800 781 1760 
Sales - International toll free: +800 4618 8463 
Sales Fax North America: +1 (506) 384-0727 
Sales Fax International:  +800 9050 7270 

General e-mail: mailto:info@dovico.com 
Support: mailto:support@dovico.com 
Online Knowledge base: http://www.dovico.com/techtips.html 
Online Support form:  http://www.dovico.com/support.html 
 
DOVICO Software 
P.O. Box 27058 
Dieppe, NB  Canada E1A 6V3 
http://www.dovico.com/ 
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Shrink/Detail, 40 
Start, 40, 77 
Start from last, 40 

Chapter 

15 



 

Page numbers show in BOLD refer to Track-IT web edition functionality 
97 

Starting Track-IT light the first time, 12 
Startup view, 26, 88 
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Task Progress Statistics, 43, 50, 57, 90 
Taskbar, 25 
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Timer toolbar, 40, 45 
Timer view, 39, 77 
Timesheet entry tools, 2 
Timesheet toolbar, 53 

Timesheet view, 53 
Titles, 21 
Track-IT light, 1, 2, 7 
Track-IT pro, 1, 5, 6 
Track-IT pro web, 2 
Track-IT punchclock, 1, 3, 92 
Track-IT Suite, 1 
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Track-IT web edition, 1, 2, 72 
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